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Notice
Read this manual carefully before any assembling and using. Incorrect handling of productsin this manual can
result in injury and damage to persons and machinery. Strictly adhere to the technical information regarding

installation requirements.

This manual is not for use or disclosure outside of Leadshine except under permission. All rights are reserved.
No part of this manual shall be reproduced, stored in retrieval form, or transmitted by any means, electronic,
mechanical, photocopying, recording, or otherwise without approval from Leadshine. While every precaution
has been taken in the preparation of the book, Leadshine assumes no responsibility for errors or omissions.

Neither is any liability assumed for damages resulting from the use of the information contained herein.

This document is proprietary information of Leadshine that is furnished for customer use ONLY. Information
in this document is subject to change without notice and does not represent a commitment on the part of
Leadshine. Therefore, information contained in this manual may be updated from time-to-time due to product

improvements, etc., and may not conform in every respect to former issues.

Record of Revisions
Revision Date Author Description of Release
1.0 Oct, 2017 MF Initial Release
31 Oct, 2018 MF, CL Software update to version 3.1 to reflect CS-D firmware upgrade
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1. Introduction

Thank you for choosing Leadshine products. The CS-D series closed loop stepper drives include 4 models, CS-
D403, CS-D507, CS-D808, and CS-D1008. When those drives are implemented with compatible stepper
motors with encoders, your maotion control system performance will get significant improvement over
traditional open loop stepper systems such as no loss of step, higher torque, lower noise & heating, and
smoother motion. Leadshine closed loop products are also ideal alternatives to replace similar frame size
brushless servo systems in low-to-middle speed applications because of their features of much lower cost,

much higher torque, and much easier system setup and configuration.

For most applications Leadshine closed loop stepper systems are easy to configure & setup and can be
implemented without any tuning efforts, same as classic open loop stepper systems. But in some cases this free
ProTuner software tool can still be used for performance tuning, and configuring custom settings like output

current, micro-step resolution, control type, etc.

2. Prerequisites

Leadshine ProTuner for CS-D closed loop stepper drivesis a free Windows based software. To successfully
run this software, the following prerequisites must be satisfied.

2.1 Operation System

This ProTuner software must be installed and run on a computer with Windows 7 or Window 10 operating
system for either 32 or 64 hit.

2.2 Motor Connection
From ProTuner software settings of a CS-D drive can be changed with or without a stepper motor connected.

e Without a stepper motor connected, a user can only use the ProTuner software to change the CS-D
drive parameter values.

e With a stepper motor connected properly to the CS-D drive, a user can not only configure settings of
the connected drive but also run the motor to test and tune motion performance. Refer to the CS-D

drive user manual for how to connect a stepper motor.
2.3 Accessories

To connect a CS-D Closed loop stepper drive to the computer, Leadshine offers a special RS232 cable (Figure
1). It can be used to connect to the RS232 connector on the computer. If such a RS232 connector does not exist

on that computer, a user can use a USB to RS232 adaptor (Figure 2) or conversion cable to get the drive
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connected. Please note that not all USB to RS232 adaptors will work. Contact your CS-D drive seller or
Leadshine technical support for getting such a USB to RS232 adaptor, which have been confirmed to work fine
with the CS-D series closed loop stepper drives.

Figure 1: RS232 Tuning cable Figure 2: USB to RS232 converter

3. Software Overview

Refer the following sections for a quick overview for this ProTuner software.

Menu bar

3.2 Work Space

Toolbar

Figure 3: Sofware workspace
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3.3 Menu and Toolbar

Menu items and respective toolbar items are described in the following table. The toolbar is one on the left

screen (Figure 3) offer the most frequency commands. Menu bar items are described below:

Menu Submenu Item Toolbar Icon Function
Open - Open an existing .Isr configuration file
Project SaveAs i fsiﬁ\e/e parameter values to an .Isr configuration
Exit - Close ProTuner for CS-D software
panrt Connect/disconnect the drive to/from the
Communiceation
s computer
Communication
7Y
Error Track - Track error history of the CS-D drive
Drive Error Track
=~
Write to Drive - Download parameter values to the drive
Write to Drive
Reset - Reset the drive back to its factory settings
Parameters C% Read or edit the CS-D drive parameter values
Parameters
Configuration
( - 1Y Motion test for the connected drive and motor;
. '@ X or, monitoring motion performance when
Motion Test
. powered by a controller, PLC, pulse
Motion Test
generator...
'\S/lo;ntvl\j;re - Quick link to the software user manual
Help
Product - The CS-D drive information

Page |3
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Information

About

Display ProTuner software information

4. Connect theDrive

Follow the following steps to connect a CS-D closed loop step drive to the ProTuner software on your

compuiter.

e Read section 2.3 first, then connect the drive to your computer through a RS232 connection.

e Power on the CS-D closed loop stepper drive.

e Launch ProTuner for CS-D software, the “Communication” screen will display (Figure 4).

ﬂ Leadshine ProTuner

!P;rnje:t Dvrve Cn;ﬁgulmn Help

Connect

Mation Test

Port:

Communication

COM1

Conmnect

Error Track

=

Write to Drive

Figure 4: Communication screen
e Select the correct COM port from “Port” dropdown list control (Figure 5). When aUSB to RS232

adaptor is used, you can go to Device Manager of your computer to find the correct port.
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Figure 5: connecting drive

Connect @ Connect @
Port: [ List Al Port: [¥] List All
CoM2 D] COM2 r
coM3 COM3 @
COM5
COMG
@ COM7

e Click “Connect” button and wait afew seconds. If the drive has been successfully connected, the

“Parameters’ screen (Figure 7) will be automatically displayed with al the parameter values uploaded

from the connected drive. Otherwise, the following error message will be displayed (Figure 6).

Communication Error

X

@W% Failed to connect! Make sure all wires are correctly connected, the

_,-'I green LED light of the drive is on, and the correct COM port has been

k..

selected.

Figure 6: Communication error message

5. Manage Drive Parameters

Settings and configurations of the connected CS-D closed |oop stepper drive are all stored in parameters. They

can be read, changed, and saved through the ProTuner CS-D software.

5.1 Read Parameters

After the CS-D closed loop stepper drive is successfully connected to computer, its current settings will be

automatically uploaded and displayed (Figure 7). The Parameters window can aso be opened any time by

clicking the “Parameters’ icon on the left toolbar or Configuration->Parameters menu item.
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) Leacshine : =
Project Diive Configuration  Help
Parameters
Al Parameters - Use the left filter to kmet/expand displayed paran
Par. #  Desophion Value *
PR 1 Mitroatep resahltion 10000
-
PR3 Clased loop holding current percentage 50
PR 4 Encoder résalution 4000
PR S ABowed max posiion amor counts 4000
FR& ALM output type 1 =
PR7  Contrel made 2 F
PRE Open leop output current percentage 50
PR11 Max bime bo dose brake 1000
PR 13 Delay of dosing brake 250
PR 12 Delay of loosening brake 250
PR 14 ENAnput signal bevel setting 1
PR15  ALM output signal mpedance state 1
PR 17  Distance to send “In Position” output sipnal 4
PR 18 Algw/desallow deanng position fallowing error 1
PR 19  Current loop bandwidth 1500
Q"‘ i PRI0  Current loop Ki 300
- PR21  Position loop Kp 25
Wirite to Dvive | | pPR22  velosity loop Kp 25
L e o

Filter Displayed Parameters

[T Py

Figure 7: Parameters

On the Parameters window, you can use the top left dropdown list control to filter the displayed parameters

(Figure 8).

5.2 Edit Parameters

Figure 8: parameter type

To edit a parameter value, double click the “Value” field for that parameter. You can then change its value.

Make sure the input value is an integer in the range defined in the “Range” field. See Figure 9.
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T - L - =]
0 x| — —

| Project Deve  Comfgurston  bslp
Parameters
LB Parameters = e the Lef fiter to Emifeapand doplayed parametes
Commuslcathon
IR Par, §  Desopuon Walug Ranigi Lind it
PR 1 Microstep resolticn 10000 200-51200 PR To thamge this value DPP switches SW1-5V
PR3 Clased loop holdng curent percentage 50 W Parcentage of PR 30; also idle ourrent in o
} Paramatens PR 4 Encoder resolution 4000 4 tmes of encoder ines. Read software ms
PRS Allceed max postion s counts 4000 Alcwid max count of postion error puliss
¥ ,_,/' PRE B iUt Dy i i - Algev: 2 - In posion: 3 - Brake, Read f
| f@ﬁ\a ol | PRT Coantrol mode F 0 = Opan loop, 2 - Choead loop; 1 - Ressnag
PRE Open loop cutput ourrent percentage 50 Percentage of PR 30; also cutput ourrent is
! Mation Test PR1T Max time to dose brake 1000
| PR 13 Doy of cloriang Braka 250 1 1
. i e kot o Double click the cell in Value
= FREL. . R i skl vl setting : column to change the value. 4
| FR15  ALM cutput signal mpedance state 1 mped ance
Errar Track PR17  Destancs to gend “In Poglon” cutpull signal i 0100 Pidaes Deatancs b target posdion o pulies for 48
| PR1E  Alow/dsallow deanng position following error 1 LN ] . @ = No, 1 - Yok Read softwars manual
| I PR 19 Cunrent loop bandwdth 1500 0-3000 Hz Recommanded for B00-2000. Read softwar
—= PR20  Current bop Ki 0 0-1000 - Read software mnisl
| PRI Posien loop Kp 5 0- 100 - Rad sofward maniad
| Wiirite o Orkes PR27  Welooty loop Kp 25 0-100 - Read softears manual
| PR 23 Weloaty loop ¥i ] - 100 ' Bead softw.are mansal
| PR 24 Ledkang duration bme 200 G-1500 1ms Badd scftware maniasl
' PRI5  Inteenal fienng tes 15 0-512 0. ims Raid Softears manisl carsfully,
| PR2Z6  Soft-starting bmes 1 =30 100ms Tima dealy for commammand smoothing., &

Figure 9: edit parameter value
When trying to make parameter value changes, please note;

e  Some parameters are read-only, and take no effect whatever you typein.

e Some parameters are only effective after the related DIP switches on the CS-D closed loop stepper
drive are set properly, such as parameters “Microstep Resolution”. Check the full parameter
description in Section 5.3.

e Some parameters are only effective after other parameters are set to certain values. Check Section 5.3.
5.3 Parameter Description
All parametersfor the CS-D series closed loop stepper drives are described in this section.
531 Microstep (PR1)
This parameter is used to set micro step resolution. To make this parameter effective,

o DIPswitches 1-4 (DP1-4) of the CS-D drive must be all set to “ON” positions.
e Itsvalue must be increased by 200 and in the range of 200 — 51,200.

532 Peak Current (PR2)
This parameter is used to set the peak current that the CS-D drive can output.

5.3.3 Closed L oop Holding Current Percentage

This parameter is a percentage value of the peak current in PR 2. It is used for both holding and idle current in

closed loop control mode (PR 7 value “2"). Increase this parameter value can improve response time and better
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torque, but may result in higher heating. For Leadshine motors, it is suggested keep the default value unless

you really make your own configurations.

534 Encoder Resolution (PR 4)

This parameter value must be set to 4 times of the encoder lines. For example, for a 1000-line encoder this
parameter value must be set to 4000.

535 Allowed Max Position Following Error Pulses (PR 5)

This parameter is used to set the allowed maximum pulse number of position errors.

53.6 "ALM" or “PEND” Output Typeon theDrive (PR 6)

This parameter is used to configure the type of the configurable digital output signal, which is marked as
“ALM” on CS-D403 & CS-D508, and “PEND” of CS-D808 & CS-D1008.

e (CS-D403 and CS-D508
The configurable digital output which is marked as“ALM”.
0 SetthisPR 6 vaueto“0” (default) to configure this output as“ALM” - fault output - signal.

0 SetthisPR 6 vaueto “1” to configure this output as “In Position” - in targeted position -
output signal.
0 SetthisPR 6 vaueto “2” to configure this output as “Brake” - brake control output - signal.
e (CS-D808 and CS-D1008
The configurable digital output which is marked as*PEND”.
0 SetthisPR 6 vaueto“0” to configure this output as “In Position” - in targeted position -

output signal.
0 SetthisPR 6valueto“1” to configure this output as “Brake” - brake control output signal.

53.7 Control Mode (PR7)

This parameter is used to set the control model that the CS-D will operate. Set its value to “0” for open loop

control; set it to “2” for closed loop control (default). Value “1” isreserved and has no effect.

5.3.8 Open Loop Output Current Percentage (PR 8)

This parameter is used to set the output and idle current in a percentage value of the peak current value (PR 2),
when the CS-D drive operates in open loop control mode. It is only effective when parameter PR 7 isset to “0”

for open loop control.

53.9 Control Type (PRY9)

This parameter is only available for CS-D808 and CS-D1008 drives. It is used to set the drive control type. Set
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itsvalueto “0” (default) for pulse & direction (also called step & direction) control; set itsvalueto “1” for
CW/CCW control.

5.3.10 PulseEffective Edge (PR 10)

This parameter is only available for CS-D808 and CS-D1008. It is used to determine when a pulse will be
recognized. Set itsvalue to “0” for rising edge (default); set itsvalueto 1 for falling edge.

5311 MaxTimeto Close Brake (PR 11)

This parameter is used to set the max time for closing the brake. It is only effective when PR 6 is set for brake

control. Usually don’t change the default value unless you really want.

5.3.12 Delay of Releasing Brake (PR 12)

This parameter is used to set the delay time before brake releasing. It is only effective when PR 6 is set for
brake control. Usually keep the default value of this parameter unless you really want.

53.13 Delay of Closing Brake (PR 13)

This parameter is used to set the delay time before starting to close the brake. It is only effective when PR 6 is
set for brake control. Usually keep the default value of this parameter unless you really want.

5.3.14 "ENA" Input Signal Level Setting (PR 14)

This parameter is used to set the “ENA” signal voltage level of the CS-D drive. Set itsvalueto “0” for high
level (default); setitsvalueto “1” for low level.

5315 "ALM" Output Signal Impedance State (PR 15)

This parameter is used to set the “ALM” signal impedance level of the CS-D drive. Set itsvalueto “0” for high
level (default); setitsvalueto “1” for low level.

5.3.16 “PEND” Output Signal Impedance State (PR 16)

This parameter is only available for CS-D808 and CS-D1008. It is used to set the “PEND” signal impedance
level of the CS-D drive. Setitsvalueto “0” for high level (default); set itsvalueto “1” for low level.

5.3.17 Distanceto Send " In Position” Output Signal (PR 17)

This parameter is used to set the distance (in number of pulses) to send out the In-Position signal. It isonly
effective when PR 6 is set for “In Position” output.

5.3.18 Allow Clearance of Position Following Error (PR 18)

This parameter is used to set whether or not clearing position following error is alowed by sending an enable
signal viathe “ENA” connection on the CS-D drive. Set itsvalueto “1” (default) for yes; set it to “0” for no.

Page |9
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5.3.19 Current L oop Bandwidth (PR 19)

This parameter is used to set the current loop bandwidth of the CS-D drive. It isfor advanced users only.
Usually keep the default value for powering Leadshine motors, or 3 party stepper motors with normal
inductance.

If the 3" party stepper motor has extremely low or high inductance, and high noise or/and vibration are found
after power-on. You can try to tune this parameter along with PR 20. Usually choose a value of 800-2000.

Follow the following steps to tune this parameter:

e Step 1: compare the read-only parameter “ Inductance” value (PR 27) on the Parameters screen with
the inductance value found on the stepper motor datasheet (ensure the accuracy of the datasheet),
when auto-tuning feature of the drive isturned on.

o Step 2: If those two valuesin Step 1 are significant different (50% or more), tune this parameter value
along with parameter PR 20.

o Step 3: If unable to find a preferred PR 19 & 20 value combination, turn off the “ Auto-Tuning” feature
via DIP switch 6 of the CS-D drive.

5.3.20 Current L oop Ki (PR 20)

This parameter is used for tuning current loop integral gain. It istuned along with PR 20 (See 5.3.19). Usually

keep the default value for Leadshine motors and 3 party motors with normal inductance.

5.3.21 Position Loop Kp (PR 21)

This parameter is used for tuning position loop proportional gain. Usually keep the default value for Leadshine
stepper motors, unless really needed to do so.

e Increasethis value will reduce position following error, but could result in motor vibration.

e Decreasethe valueif the motor vibrates.

5.3.22 Velocity Loop Kp (PR 22)

This parameter is used for tuning velocity loop integral gain. Usually keep the default value for Leadshine
stepper motors, unless really needed to do so.

e Increase the value can increase velocity stiffness.

e Reduce this value when the motor vibrates at low speed.

5.3.23 Veocity L oop Ki (PR 23)

This parameter is used for tuning Velocity loop proportiona gain. Usually keep the default value for Leadshine
stepper motors unless really needed to do so. This parameter is usually tuned along with PR 22. Set it to O if
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the motor shakes during settling.

5.3.24 Motor _Shaft Locking Time (PR 24)

This parameter is used to set the motor shaft locking time. Usually keep the default value, unless you really

want to make a change.

5.3.25 |Internal Filtering Time (PR 25)

This parameter is used to configure the time for internal command filtering. In some applications, change this

value could improve overall system performance.
Note: for multi-axis systems with interpolation, this value must be set to the same for all axes.

5.3.26 Soft-Starting Time (PR 26)

This parameter is used to configure the internal smoothing time for the CS-D drive initial current ramp-up

when the drive isturned on. Increase this value if there is a motor overshooting like “JUMP” at powered-on.

5.3.27 Motor Inductance (PR 27)

This parameter is read-only, when the Auto-Tuning on the drive is turned on. It is for reference only.

5.3.28 Auto-Tuning at Power-on (PR 28)

This parameter is used to set if the drive auto-tuning is turned on at power-on. It is read-only parameter for

informational only. Its valueis actually determined by dip switch SW6 of the CS-D drive.

5.3.29 Veocity Switching Point: Open L oop to Closed L oop (PR 29)

This parameter is used to set the velocity switching point from closed loop control to open loop control.
Usually keep the default value. Only change it when it causes motor vibration at this mode switching velocity

point.

5.3.30 Veocity Switching Point: Closed L oop to Open L oop (PR 30)

This parameter is used to set the velocity switching point from closed loop control to open loop control.
Usually keep the default value. Only change it when it causes motor vibration at this mode switching velocity

point.
5331 Motion Type (PR 31)

This parameter is used to set motion type based on your application. It currently contains the following motion
types:

e “Normal”: thisisthe default motion type for normal applications.
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e “Fast response”: this motion typeis suitable for applications with high acceleration applications. For
example, select this type may improve system performance for application such as many bonding
type machines frequently seen in electronics.

e “Low speed circular interpolation”: this motion type is suitable for some applications requiring

circular interpolation at extralow speed (< 60 RPM).

Usually keep the default setting, unless this motion type can’t meet your requirement and your application falls

into one of the other listed motion types.

5332 Sdf-Tedt at Power-on (PR 32)

This parameter is used to indicate if auto-test set homing will be performed at power-on. When its value set to
“1”, the motor will rotate half arevolution in each direction (clockwise and counterclockwise) at power-on.

When set to “0”, there is no effect for this parameter.

5.4 Motion Test

Open the Motion Test window (Figure 10) by clicking “Motion Test” icon on the toolbar or
Configuration->Motion Test menu item for configuration performance test. This Motion Test window of

ProTuner software can be used to:

e Perform motion performance test for current drive parameter setting. Read section 5.4.2
e Monitor motion performance when the CS-D drive takes control signals from a connected motion

controller/PLC/pulse generator ...

541 Motion Test Window

The Motion Test Window includes 3 areas marked in Figure 10, “ Scope”, “Motion Parameters’, and “Motion
Testing”.
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Figure 10: Motion Test window

Mation Test

Red “Position Error” curve
displayed here for Channdl 1

PRGN [P S

Blue “Velocity Feedback” displayed
here for Channel 2 selection

4 Charndl |  Poston Eivor OF - & Channel 7 veleoiy Fasdback (RPs -

Thetop “Scope” (Figure 11) area of the Motion Test window contains a scope used to display colored
curves based on what have been chosen on Channel 1 and Channel 2 dropdown lists during the test.

Page | 13



CS Series Closed-loop Stepper Drives Software Manual V3.1

Figure 11: Scope portion of Motion Test window

Available options for Channel 1 add 2 dropdown list controls include “Position Error”, “Velocity
Feedback”, “Position Feedback”, *Velocity Targeted”, “Positon Targeted”, “ Synthetic Current”, “Bus
Voltage’, “ A Phase Current”, and “B Phase Current”. See Figure 12.

¥ Channel 1 |ZEEi=itnac l:]

--Select--

Speed (rpm) 33 velocity Feedback (RPM)
Postion Feedback (P)
Velocity Targeted (RPM)
Position Targeted (P)

Distance (r) 2CSynthetic Current (mA)

Bus Voltage (0.1V)

A Phase Current (ma)

B Phase Current (mA)

Repeat # 1

Figure 12 curve type options

The bottom left “Motion Parameters’ area (Figure 13) of the Motion Test window displays editable
text fields and selectable radio buttons for the motion test.

Spaed (rpm) 350 Accleration [rs~2) 200 it
& Oockmia
Courdprdockria
Distance (1) 200 vl () 100 R
nidiredticn
Ropoat @ 1 Sampang Intersal (0.2ms) g & Bk and brth

Figure 13: motion test parameters
Find those parameter description in the following table

Item Description Range
Speed (rpm) Targeted velocity of the motion test. 1- 5000 rpm
ACC(?_I/g;“ on Acceleration of the motion test. 1-3000 r/s"2

Movement distance in number of

Distance (r) revolutions, for the motion test. 1- 855 revolutions
Interval (ms) Interval between two movements. 1-32767 ms
Repeat # Repeat times of the motion test 1-65535
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54.2

Sampling Interval between two data samplings 1-50
Interval
Rotation Motor initial rotation direction Clockwise, or -
Counterclockwise
Direction Type of rotation directions for motion test Unidirectional, or Back and

forth

The bottom right “Motion Testing” area of motion test window (Figure 14) is used to choose what
motion test type to perform. Select “Performance Tuning” to tune the CS-D drive; choose * Scope” for
motion performance monitoring when the CS-D drive takes control commands from a connected
controller.

Motion Test Type

@ Performance Tuning

Scope

) Start

Figure 14: Motion test type selection

Tuning Performance Testing

To tune and test the performance for the current drive settings

Connect the CS-D driveto ProTuner software.
After parameter values uploaded to the software, you can choose to make value changes or not as
needed.
Switch to the Motion Test window by clicking “Motion Test” icon on the left toolbar.
Keep the default selection of “Performance Tuning” option (Figure 14).
Choose what to display on the scope for Channel 1 and 2 (Figure 12).
Fill in test motion parameters (Figure 13).
Click thee* Start” button to start motor rotation.
Test the mation performance by checking:
0 Thecurvesdisplayed on the scope (Figure 12),
0 Themotor and drive noise, vibration, heating, etc.
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543

M otion Perfor mance Monitoring

Besides used for motion performance testing for the current CS-D drive setting when ProTuner itself is used to

control commands, the Motion Test window can also be used for motion performance monitoring when the

driveis controlled by an external pulse generator (controller, PLC, etc.). For example, a user can use the

proTuner software to monitor the motion performance of certain axis in a machine which is powered by a CS-

D drive, but its motion commands are sent from the machine’'s motion controller.

Follow the following steps:

Connect ProTuner software to the CS-D drive which is commanded by an external controller.
Switch to the Motion Test window by clicking the “Motion Test” icon on the left toolbar.
Select “Scope” option for “Mation Test Type” on the bottom right side. See Figure 15.
Choose what to display on the scope for Channel 1 and 2 (Figure 12).
Keep the default value or enter a new value for the “ Sampling Interval” timefield.
Click “Start” button to start monitoring.
Start motion from the pulse generator connected to the CS-D drive.
Monitor the motion performance by checking:

0 Thecurves displayed on the scope (Figure 12),

0 Themotor and drive noise, vibration, heating, etc.

Figure 15: motion performance monitoring
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6. Writeto Drive (Download to Drive)

After parameters tuned & optimized and motion performance tested, you must download their changesto the

drive. Otherwise, those changes will be lost next time when the drive is re-powered.
Following the following steps to write parameters to the drive.

e Click the “Write to Drive” icon on the left toolbar, or Configuration->Parameters menu item. A
confirmation will be popped up (Figure 16)

-
Write to Drnve Confirmation | i

Current drive settings won't be recoverable after paramieters witten lo
I drive. Do you want to procesd!

Figure 16: Write to drive confirmation message

o Click “Yes’ to continue downloading parameter values to the CS-D drive.

o After parameters are successfully written to the drive, a success message (Figure 17) will be popped
up. Now, all the changes are permanent and new settings for the CS-D drive will take effect next time
when the drive is re-powered.

Download to Drive Success S|

l _ Parameters have been written to drive seccessfully!

|

Figure 17: Write to drive success message

7. Resetting Drive

To reset the current drive configurations back to factory settings, follow the following steps.

o Click Drive->Reset menu item. The confirmation message will be popped up (Figure 18).
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" Reset Confirmation - [F—
|

I , Areyou sure to reset cumrent drive settings back to factory settings?

Figure 18: resetting confirmation message
Click the “Yes" button to continue resetting process, or click “No” button to cancel. After resetting
finished, the following informational message (Figure 19) will be displayed. Factory settings will take
effect next time when the drive is powered next time.

Reset Status 22

l _ Drive has been successfully reset back to factory settings

Figure 19: reset success message

8. Manage Configuration File

After the drive performance is tuned and parameter values optimized, its settings can be saved to a

configuration filein .lsr format. You can aso open an existing .Isr configuration file and load the settings to the
ProTuner CS-D software.

7.1 Open a Configuration File

Follow the following stepsto load settings from an .Isr configuration file

Click Project->Open menu item. The File Open window will be displayed (Figure 20).
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6 Pa.lrlmetu -Tablz -

e —

o

M o Users » hwtest ¢ Desktop » test

Mew folder

s

’ Organize -

M Favorites
Bl Desktop

& Downloads
* % Recent Places  |=

+a Libraries
;f Decuments
.;l"l Music
” | Pictures
B videos

|
» B Camnuter

Name

|| testlsr

4

File name: test.lsr

m

- | +y | | Search test

r
= -l ﬂ
Type

Date modified

2008/9/19 11:46 L5R File

- [.I.;r Files(® lsr} -

)Op:n H[ Cancel

Figure 20: open an .Isr configuration file window

Find and select the .Isr configuration fil click “OK” button.

After the configuration file is open, a message (Figure 21) will be displayed; all the parameter values
stored in that configuration file will be loaded and displayed in the Parameters window. You can now
tune those parameters or directly download them to the connected CS-D closed loop stepper drives.

— — i i

Load File

; IH Configuration file has been loaded successfully.

Figure 21: Open file confirmation

After aconfiguration file is opened, to get back to its original settings you will need to repower the CS-D

closed loop stepper drive.
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7.2 Save a Configuration File

Follow the following steps to save the current parameters into an .Isr configuration file

Click Project-> Save As menu item. The following screen on Figure 22 will be displayed:

(@ svens A — sz

w « Users b hwtest » Desktop b test v+-,-||'--_:“=*—_ ):-j_

i _{Jfganizc - = -Ncw folder = w .Q.
b Favorites - Mame . Date modified Type

‘ B Desktop Mo items match your search,

m

& Downloads
1= Recent Places

=4 Libraries
:] Documents
@' Music
&= Pictures
l ﬂ Videos - 4 ne L3

File name: ‘ttsd( -

Save as type: |Jsr Files{*.lsr) vl

. Hide Folders ..--' Save ] [ Cancel ]

Figure 22: save configuration file

Choose the location and file name and click the Save button.

9. Manage DriveError History

You can use the ProTuner for CS-D software to track error history previously happened to the connected CS-D

closed loop stepper drives. Follow the following steps for that:

Click Error Track icon on the left toolbase or click Drve->Error Track menu item, the Error Track

window (Figure 23) will be displayed.
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&) Leadshine ProTuner for C5-0 = | B S|

Project Drive Configuration Help

Error Track

Last Error | Previous Error(s)

Communicatian Error # Name Class Suggestion

2T

Parameters

@@L

Motion Test

o

Error Track

=N

VWrite to Drive

Figure 23: Error Track window

o Click the “Previous Error(s)” tab to see error(s)previously happened in the past.

10.Help Menu

10.1 Software Manual

When clicking Help-> Software menu item, the software manual will be opened.

10.2 Product Information

To display the product information of the connected CS-D closed loop stepper drive, click Help->Production
Information menu item. The message window in Figure 24 will be displayed.

Figure 24. Product information
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10.3 A bout

To display the software information, click Help->About menu item. The message window in Figure 25 will be

displayed.

About

S5

2

Leadshine Protuner for C5-D

Version 3.1

Copyright (C) 2018 Leadshine Technology Co., Ltd.

O

Figure 25: Software information

Page | 22



CS Series Closed-loop Stepper Drives Software Manual V3.1

Appendix - Parametersfor CS-D closed loop stepper drives

1) CS-D403 and CS-D508 Closed L oop Stepper Drive Parameters

Parameter

Default

4 Name Value Range Unit Remark
To change this value, DIP switches
Microst Pulse / SW1-SW4 on the drive must be all set
PR1 resol utigﬁ 1600 200-51200 revolution to "ON" positions. Its value must be
increased by 200 such as 200, 400,
800, 1000, ...
25
PR 2 Peak current (nglos) 10-80 0.1A Drive's max output current.
(CS-D508)
Closed loop 40 Also used by idle current in closed
CS-D403
PR 3 holding current ( ) 10-100 % loop control mode. .1) Percentage of
ercentage 50 peak current (PR 2); 2) Only available
P « (CS-D508) when PR 7 value set to 2.
This value must be 4 times of encoder
Encoder Count/ | lines. For example, this value muse be
PR4 resolution 4000 200-20000 revolution | set to 4000 for a motor with a 1000-
line encoder.
Allowed max
position s .
PR5 . 4000 0-65535 Pulse Threshold for position following error.
following error
pulses
" " Setting for the “ALM” output on the
PR 6 tAIél\gn gﬁt/pst 1 1-3 - drive: 1 —Alarm; 2 - In position; 3 -
P Brake.
i i Control mode setting: 0 - Open loop, 2
PR7 Control Mode 2 0-2 - Closed loop; 1 — Reserved
Output current in open loop control
Open loop output mode which is apct. value of peak
PR 8 current 50 0-100 % .
ercentage current (PR 2). Only effective when
percentag PR 7 set to value 0
Max timeto Only available when PR 6 set to 3.
PR11 close brake 1000 100-10000 ms Usually keep this default value.
Delay of Only available when PR 6 set to 3.
PR12 releasing brake 250 0-1500 ms Usually keep this default value.
Delay of closing Only available when PR 6 set to 3.
PR13 brake 250 0-1500 ms Usually keep this default value.
PR 14 ENA input signal 1 0-1 ENA effective voltage level setting: O -

level setting

high level, 1- low level
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PR 15

PR 17

PR 18

PR 19

PR 20

PR 21

PR 22

PR 23

PR 24

PR 25

PR 26

PR 27

PR 28

"ALM" output
signal impedance
State

Distanceto send
"In Position"
output signal
Allow clearance
of position
following error

Current loop
bandwidth

Current loop Ki

Position loop Kp

Velocity loop Kp

Velocity loop Ki

Motor shaft
locking time

Internal filtering
time

Soft-starting time

Motor inductance

Auto-tuning at
power-on

1

1500

300

25

25

200

15

0-100

0-3000

0-1000

0-100

0-100

0-100

0-1500

0-512

1-30

0-10000

pulse

Hz

ms

ms

0.1s

Setting for “ALM” output impedance
level: O - high impedance; 1 - low
impedance

Distance to target position in number
of pulsesto send "In Position" output
signal. Only available when PR 6 set to
“In Position”

Setting for allowing position error
clearing via“ENA” signal on the drive
without re-powering of the drive: O -
No, 1- Yes.

Usually keep the default value.

Recommended for 800-2000.

Current loop integral gain. Usually
keep the default value.

Position loop proportional gain. 1)
Increase this value can reduce position
following error. 2) Decrease the value
if the motor vibrates. 3) Usually keep
the default value.

Velocity loop proportional gain. 1)
Increase the value can increase
stiffness. 2) Reduce this value when
the motor vibrates at low speed. 3)
Usually keep the default value.
Velocity loop integral gain. Usualy
keep the default value. Set it to O if the
motor shakes during settling.

Usually keep the default value. Reduce
thisvalue if you want to shorten the
time of locking shaft.

Internal smoothing time for control
commands.

Note: for multi-axis systems with
interpolation requirements, this value
must be set to the same for all axes.

Internal smoothing time for starting
current. Increase this valueif thereisa
motor overshooting (“Jump”) at
power-on.

Read-only parameter and for reference
only, when the drive Auto-Tuning
feature on the drive is turned on.

Read-only parameter. Itsvaueis
determined by if the “auto-tuning” has
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PR 29

PR 30

PR 31

PR 32

Note: All parameter values for CS-D403 and CS-D508 must be integers.

Velocity
switching point:
open loop to
closed loop
control

Velocity
switching point:
closed loop to
open loop control

Motion type

Self-test
indicator at
power-on

18

12

0-100

0-200

0-10

0.1r/s

0.1r/s

been turned on from DIP 6 of the
drive: 0-No, 1-Yes.

Usually keep the default value. Only
change it when it causes motor
vibration at this mode switching
velocity point.

Usually keep the default value. Only
change it when it causes motor
vibration at this mode switching
velocity point.

Setting for motion type:

0 - Normal, 1- Fast response, 2- Low
speed circular interpolation, reserved
for the rest. Usually keep the default
value.

0-No, 1- Yes. When turned on (value
“1"), the motor will rotate half aturn
on each direction at power-on.
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2) CS-D808 and CS-D1008 Closed L oop Stepper Drive Parameters

Parameter Default .
4 Name Value Range Unit Remark
To change this value, DIP switches
Microst Pulse/ SW1-SW4 on the drive must be all set
PR1 reslu gﬁ 1600  200-51200 revolution | 10 "ON" positions. Its value must be
increased by 200 such as 200, 400,
800, 1000, ...
PR 2 Peak current 80 10-80 0.1A Drive's max output current.
oo o sy e doss
. i 0 .
PR3 hggg}? Clérrent 10-100 % peak current (PR 2); 2) Only available
P g when PR 7 value set to 2.
This value must be 4 times of encoder
Encoder 4000 Count/  lines. For example, this value muse be
PR4 resolution 200-20000 revolution | set to 4000 for a motor with a 1000-
line encoder.
Allowed max
PR5 position 4000 0-65535 Pulse Threshold for position following error.
following error
pulses
PR 6 "PEND " output 0 0-1 i Setting for the “PEND” output on the
type on drive drive: 0 —In Position; 1 - Brake.
2 i i Control mode setting: 0 - Open loop, 2
PR 7 Control Mode 0-2 - Closed loop: 1 — Reserved
Open loob outout Output current in open loop control
P P outp 50 mode which is a pct. value of peak
PR 8 current 0-100 % .
ercentage current (PR 2). Only effective when
P g PR 7 st to value O
PR9 Control type 0 0-1 - 0- PUL /Dir, 1- CW/CCW
PR 10 zésee effective 0 0-1 i 0- Rising edge, 1 - Falling edge
Max time to 1000 i Only available when PR 6 set to 3.
PRIL ' Gosebrake 100-10000 - ms ' yqally keep this default value.
Delay of 250 i Only available when PR 6 set to 3.
PRI2 | roeasing brake 0-1500 MS | Usually keep this default value.
Delay of closing 250 i Only available when PR 6 set to 3.
PR3 prake 0-1500 MS | Usually keep this default value.
PR 14 ENA input signal 1 0-1 ENA effective voltage level setting: O -

level setting

high level, 1- low level
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PR 15

PR 16

PR 17

PR 18

PR 19

PR 20

PR 21

PR 22

PR 23

PR 24

PR 25

PR 26

"ALM" output
signal impedance
State

"PEND" output
signal impedance
setting

Distance to send
"In Position"
output signal

Allow clearance

of position
following error

Current loop
bandwidth

Current loop Ki

Position loop Kp

Velocity loop Kp

Velocity loop Ki

Motor shaft
locking time

Internal filtering
time

Soft-starting time

0-1

1 0-1
8 0-100

1 0-1
1200 0-3000
200 0-1000
45 0-100
15 0-100
0 0-100
200 0-1500
15 0-512

8 1-30

pulse

Hz

ms

ms

0.1s

Setting for “ALM” output impedance
level: O - high impedance; 1 - low
impedance

Impedance setting for the “PEND”
output on the drive: 0 - high
impedance; 1 - low impedance
Distance to target position in number
of pulsesto send "In Position" output
signal. Only available when PR 6 set to
“In Position”

Setting for allowing position error
clearing via“ENA” signal on the drive
without re-powering of the drive: O -
No, 1- Yes.

Usually keep the default value.

Recommended for 800-2000.

Current loop integral gain. Usually
keep the default value.

Position loop proportional gain. 1)
Increase this value can reduce position
following error. 2) Decrease the value
if the motor vibrates. 3) Usually keep
the default value.

Velocity loop proportional gain. 1)
Increase the value can increase
stiffness. 2) Reduce this value when
the motor vibrates at low speed. 3)
Usually keep the default value.
Velocity loop integral gain. Usualy
keep the default value. Set it to O if the
motor shakes during settling.

Usually keep the default value. Reduce
thisvalue if you want to shorten the
time of locking shaft.

Internal smoothing time for control
commands.

Note: for multi-axis systems with
interpolation requirements, this value
must be set to the same for all axes.

Internal smoothing time for starting
current. Increase this valueif thereisa
motor overshooting (“Jump”) at
power-on.

Page | 27



CS Series Closed-loop Stepper Drives Software Manual V3.1

PR 27

PR 28

PR 29

PR 30

PR 31

PR 32

Note: All parameter values for CS-D808 and CS-D1008 must be integers.

Motor inductance

Auto-tuning at
power-on

Velocity
switching point:
open loop to
closed loop
control

Velocity
switching point:
closed loop to
open loop control

Motion type

Self-test
indicator at
power-on

18

12

0-10000

0-1

0-100

0-200

0-10

0.1r/s

0.1r/s

Read-only parameter and for reference
only, when the drive Auto-Tuning
feature on the drive is turned on.

Read-only parameter. Itsvaueis
determined by if the “auto-tuning” has
been turned on from DIP 6 of the
drive: 0- No, 1- Yes.

Usually keep the default value. Only
change it when it causes motor
vibration at this mode switching
velocity point.

Usually keep the default value. Only
change it when it causes motor
vibration at this mode switching
velocity point.

Setting for motion type:

0 - Normal, 1- Fast response, 2- Low
speed circular interpolation, reserved
for the rest. Usually keep the default
value.

0-No, 1- Yes. When turned on (value
“1"), the motor will rotate half aturn
on each direction at power-on.
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